Quick Start Manual

Introduction

ERGO 4 is a complex program. We have tried to make it as intuitive as possible, and consistent
with the common Windows behaviors. Nevertheless, running ERGO 4 for the first time can be
formidable. The purpose of this Quick Start Manual is to guide first time users through some of
the concepts needed to get down the learning curve quickly.

Other resources that are available to support a quick start are:

e The Help File, which is available from the Help Menu, and also as a printed version which can
be downloaded from our web site.

e A Quick Start Wizard, which runs the first time you use ERGO 4, and automates some of the
set-up requirements and concepts outlined in this manual.

If you run into any problem setting up and using ERGO, please contact us by e-mail at
ergo@swldx.com.

Program Screen Overview

ERGO 4 is comprised of multiple windows, each of which supports some specific functionality.
First, there is the main program window. Second, there are individual small windows which
support program features, such as controlling a receiver. Third, there are data windows which
follow the Multiple Document Interface (MDI) architecture.

When you first run the program, and have not activated any of its features, you see an empty
frame that looks like this.
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Don't worry, this empty frame is normal. All the features are there, they just have not been
activated yet. You open data bases used the “File” Menu, including “File — Open” for existing
data bases, and “File — New" to create new data bases using the Data Support Interface wizard.
You activate most other ERGO features using the “View” menu.

Let's activate a few data bases and program features, and take a look at the changes.
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There are three working areas on the ERGO frame.

e The lower right of the window (labeled A) is the MDI data window area. You can open
any number of data windows and arrange them in this area of the screen.

e The left side of the main window (labeled B) is the function window docking area. You
can open any of the ERGO function windows using the View menu item. When a function
window, such as receiver control is first opened, it floats in the center of the screen. You can
leave it floating if you wish. Or, you can drag the window to the left side of ERGO, and dock
it there. In Figure 2, a receiver control window and the map have been opened, and docked.
There are three docking locations, and these windows can also be docked on top of each
other and viewed one at a time. Each individual data window also has its own toolbar for
quick access to the most frequently used data functions,, which can also be accessed from
the main menu Data item, which appears whenever a data window is open.
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The top of the main window just below the main menu (labeled C) is the toolbar area.
Most, but not all, of the function windows have two sizes. Large, which is shown in *B”, and
small windows which can be placed in the toolbar, which is shown in “*C”, where the
propagation window and status window have automatically shrunk to fit.

This architecture was designed for ERGO to enable you to make the best use of your screen
space and customize the functional appearance to best suit your needs. If you close ERGO with
all of these windows open, they will be positioned the same way the next time you start the
program.

There are also some additional screen captures on our web site showing different configurations
and operating systems. You can view them at http://www.swldx.com/ergo41.htm.

Linking the Windows Together

ERGO automatically links functionality between its open windows. For example:

If you click on a row in your data window, the map and propagation windows will update to
show propagation to the station location in the data window, and the map will update to
show the signal path, and transmitter bearing. (This assumes your data record contains
location and bearing information for the station.)

The status window (shown in the toolbar at the left in Figure 2) is linked to the internet to
obtain the latest propagation forecast from the Internet, and display it, as well as update the
Flux and K Index for the propagation and map windows.

The data windows can be linked to one of up to two active receiver control windows. This
has two benefits. First, when you click on the Frequency column in a data record, the
receiver is automatically tuned to that frequency. Second, when you press the Find button in
the data window toolbar, the data based will search itself and display the record which
matches the frequency tuned on the receiver. Also, if you activate the Track feature in a
data window, the active database will follow along with any receiver frequency changes,
showing it's best guess at the station on the active frequency.
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Getting Started

We recommend that your first objective should be to master the features described above, and
visualized in Figure 2. To summarize, this will enable you to tune your receiver, link it to an
active data base, and coordinate propagation and path display. A good way to start is to import
either the ILG Radio data (from their web site) or the HFCC data from our web site. Both are
read-only SWBC data bases which are freely available.

Connecting to Your Receiver

First things first. Let’s get the receiver connection going and identify your geographic location.
Both of these can be done through View — Properties — Set Up page from the main menu. (They
can also be done through the Quick Start Wizard when the program first runs.)

The Setup page (tab) of Properties is shown in Figure 3.

Ergo 4 Properties

Metwork | Beta
Setug I Propagation

Mame of *our Location
“our Latitude

our Longitude

| references | audio
| Locetions | colors | Updates
iCaIgar\;
|51 Worth
115 st

Configure Receivers and Connections

Radio 1 AR3030 on Comm: 2
Radio 2 *Remote Direct DCOM on 65.144 157 236

Configure |

ke

Cancel

Figure 3

Type in the name of your
location, and set your
latitude and longitude.
(South latitude and West
longitude are entered as
negative numbers.) This
step is required in order for
the mapping and propagation
features to know your
receiving location and
provide meaningful
information.

Then, you should set up your
first receiver to control by
pressing the Configure
button in the lower half of
the Setup page.
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ERGO enables you to control two receivers simultaneously, as Radio 1 and Radio 2. There are
two processes you need to understand — Installation and Assignment.

| =
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Figure 4

Installation means that you
have told ERGO you have a
certain radio you want to
control, given it a name,
selected the proper driver and
assigned a serial port. You can
Install at least ten different
receivers.

Once you have Installed a
receiver, you can Assign it by
name to either Radio 1 or Radio
2. After you have made these
assignments, the receiver
name(s) will show up in the
View menu of the main
program, and this is the menu
item you use to open or close
the receiver.

When the receiver configuration wizard opens, there are two choices of primary interest.

e Change Radio Assignments. This means if you have already Installed at least one or more

receivers, you can assign one of them to Radio 1 or Radio 2.

e Set Up A New Receiver. If you have not Installed a receiver, this is the choice for doing the

installation process.

So, if you need to set up your receiver for the first time, select “Set-up a New Receiver” and

press Next.
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This opens the Installed Receivers screen, which is shown in Figure 5.
To Install a receiver, press the “Add Receiver” button. A new row will appear in the grid.

There are three columns to set up. The first column is Receiver Name. When you press “Add
Receiver” this column will contain the word "NEW"”. Select this text, and create a new name for
the receiver. The name must be Upper Case Letters or Numbers, no longer than six characters.
So, for example, we have changed “NEW” to “"AR3030".

The second column is Receiver Driver. ERGO supports dozens of receivers, and each one
requires a specific driver to work properly. Use the drop down list to find the appropriate driver
for your receiver, in this case AOR AR3030.

The third column is Serial Port. You must connect your receiver to the computer with a serial
cable. (Some of the receivers require a null model cable — see the Help file topic for your
receiver.) Select the port that you plan to use.

After you have filled in
these three columns and
metalied BeceRers ensured that they are
correct, press Next.

ERGO 4 Receiver Configuration

=
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o or getting confused about
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trying to control two
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name to differentiate
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Figure 6
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One you have completed Installation, pressing Next will take you to the Assignment screen. (By
the way, this is the screen you would have opened if you had selected “Change Receiver
Assignments” earlier on. The Assignment screen is shown below in Figure 7.

= ERGO 4 Receiver Configuration
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Figure 7

Note: The above picture shows the selection of “*Remote Direct DCOM". This means that you
are controlling a receiver on a remote computer over the LAN or Internet, at the IP address
shown. To control a receiver over a network, you must set up a PC to serve your receiver to the
network using ERGO4SERVER program. See the Help file for more information.

Automating Propagation Parameters

Before we move on, refer back to Figure 3 for a picture of the Properties Box. You should go to
the Updates Tab and enable automatic Propagation Updates over the Internet. This will
provide you with the latest propagation information automatically. We suggest you select
“Automatic When On Line Only”.

You should also go to the Propagation Tab and check “Automatic Flux and K Index Update
from Ergo4Net”. If you don't do this, you will have to change these parameters manually in this
Tab.

That completes the things you need to do to set up a receiver, and get the propagation and
mapping features going.
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Using Your First Data Base

As mentioned before, the easiest way to become familiar with the basic ERGO data base
concepts is to get one of the read-only SWBC data sets up and running.

The simplest is the HFCC database.

¢ Go to the Download page on our web site at http://www.swldx.com/download.htm.
¢ Click on Download the current HFCC database, and download the zip file.

¢ Create a unique folder and extract the zip file contents into that folder.

e Open ERGO 4, activate File — Open and select the database in the unique folder where you
stored the zipped files.

e The HFCC database will now open in ERGO.

HFCC has been preformatted for ERGO 4. ERGO has an internal data structure using Paradox
tables and indices. The HFCC database will be called something like *HFCC_A04.DB” and will
also be indexed on its key fields.

(If you want more information about the ERGO data structure and how to do data bases in detail,
see the Help File, as well as a Data Manual you can download from our web page.)

The next simplest approach to use the available ILG Radio data base. This database is in a
unique file structure created by ILG Radio. The ERGO Data Support Interface automates most of
what is required to structure the ILG Radio database into the working format required by ERGO.

e Go to the ILG web site. A link is available on our Links page at
http://www.swldx.com/links.htm.

¢ Download the dBase IV Format (without DOS graphics) in a zip file, something like
ilgaimpo.zip. Extract the contents into a temporary folder.
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Select Wizard Mode
" Create Default (Basic) Database ¢ |mport D43 Data File

{~ Create Custorn Database i~ |mport Fineware S Update
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= Irmport WHAMLog

Back | Next I

Figure 8
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Run ERGO 4 and select File — New from the main menu. This will open the Data Support
Interface Wizard, which is a program used for importing or creating data bases. Select
“Import ILG Radio” and press Next. See Figure 8.

e Then fill in two boxes. First, select or enter the name of the ILG Radio source file in the
temporary folder (the file you just extracted from the archive). This is the first row in
Figure 9.

e Second, create the name that you want to call the working copy you are creating “ILG Radio
Working Database” — this will also require creating a new, unique folder to store the working
copy. This is the second row in Figure 9.

e Then press Next. The wizard will import, format and index the ILG Radio data, which you
can then access through the File — Open command in the main menu.

i ERGO 4 DSI EE3
Select Files
ILGRadio Source File ﬂ
ILGR adio ‘orking D atabaze H

Back I eSS

Figure 9

At this point, you have completed all the steps to make the functionality shown in Figure 2
available.

There are many other types of data bases and logs you can create and use. For more
information, see the Help File or the Data Manual (which can be downloaded from our web site.)
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Functional Windows

The following functions are available by activating windows from the View item of the main
menu.

Status. Displays date, time and propagation information.

Radio 1 and Radio 2. These menu items will take on the name that you gave to each of your
Installed receivers. Use the menu item to open or close the receiver control window.

Map. Displays either a Mercator or custom Azimuthal Equidistant map of the world, as well as
propagation paths and other information.

Propagation. Display basic propagation information from your location to the distant transmitter,
including MUF, LUF, Field Strength and Signal to Noise Ratio estimates. Uses location
information from a data base, or you can click on the map to estimate propagation to any
location. You can also print a report.

Forecast. Estimate propagation to any location for any date, time, Solar Flux, K Index, etc.
Results are displayed on the Map and Propagation Window.

Audio. Connect your receiver audio to the sound card. The Audio Window enables you to make
and save audio recordings, as well as perform DSP noise reduction and filtering on the received
audio.

Profile / Scan. By creating Profiles and Scans, you can use your receiver to build a profile of
signals on a given band, or to scan a group of frequencies. For example, you can use a second
receiver for scanning while listening to the main receiver.

Recorder. This is a VCR-like function, enabling you to program unattended audio or data
recordings of frequencies or bands of frequencies.

Properties. See Figure 3. This is the main configuration window for ERGO.
Propagation. A written propagation report obtained from the Internet.

Record Now. Activate a recording immediately.
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